C.A.T.A. Conference 2007
Class Registration (County Employee Rates)

Monday - October 1, 2007

DPT Classes
Basic Title Conveyance (2 day) $10.00 [ ] Abatements (% day) $10.00 [ ]
USPAP (7 hour update class) Includes manual & materials (Full Day/9:00amstart) $75.00 [ ]
Outside Providers
Mobile Technology for the Real Estate Professional - Presented by Apex (1/2 day/ 12:30pm start) No Charge [ ]
Tuesday - October 2, 2007 |
DPT Classes
Advance Income (2- Days/Tested) $20.00 [ ] Cost Market & Income Review (2-Days) $20.00 []
Rural Structures (1-Day) $10.00 [ ] Oil and Gas Equip. Valuation( 1-Day) $10.00 [ ]
Time Trending (1-Day) Class size limited to 12 $10.00 [] Introduction to State Assessed (1-Day) $10.00 []
Certification to Taxing Entities (1-Day) $10.00 [ ] Manufactured Homes (1-Day) $10.00 [ ]
Outside Providers
AS A--Introduction to Commercial Property Appraising (1-Day) $75.00 [ ]
Kaplan College - Houses: Toxic Mold Alert and An Insiders Look At The Hazards Inside (1-Day) $75.00 []
Thimgan & Associates - Introduction to SPSS (3-Day) $115.00 [ ]
Wednesday - October 3, 2007 |
DPT Classes
Advance Income (2- Days/Tested) 2nd Day [] Cost Market & Income Review (2- Day) 2nd Day []
Complex Residential (2-Days/Tested) $20.00 [ ] Condominium Valuation (1- Day) $10.00 []
Oil and Gas Netback (1- Day) $10.00 [ ] Statistics (2-Day) Class size limited to 12 nottested ~ $20.00 [ |
Personal Property (2-Day) not tested $20.00 [] Exemptions (1- Day) $10.00 []
Sales Confirmation (I1- Day) $10.00 [ ]
Outside Providers
Thimgan & Associates - Introduction to SPSS (3-Day) 2rdDay [ ]
James G. Felt -Water Law I & II - Water Rights and Their Valuation (1 or 2 day) $65.00/day [ ]
Thursday - October 4, 2007 |
DPT Classes
Property Design & Measurement (1-Day) $10.00 [ ]  Oil and Gas Pipeline (1- day) $10.00 [ ]
Complex Residential Property (2-Days/ Tested) 2ndDay [ ]  Statistics (2-Day) Class size limited to 12 nottested ~ 2nd Day [ ]
Personal Property (2-Days) not tested 27dDay [ ]  USPAP (7 hour update class (If over-enrollment $75.00 [ ]
warrants)
Outside Providers
Thimgan & Associates - Introduction to SPSS (3-Day) 3 Day [ ]
James G. Felt ~-Water Law I & II - Water Rights and Their Valuation (1 or 2 Day) $65.00/day [ ]
ASA- The Logic and Critical Thinking of Appraising & Communicating Appraisal Results $75.00 [ ]
TIA AO- How to Critique an Appraisal $75.00 []
McKissock- Appraisal of REO’S and Foreclosed Properties $75.00 []

**PLEASE CHECK THE ABOVE CLASSES AND COMPLETE THIS PORTION***
EARLY REGISTRATION DEADLINE ~ July 20, 2007

Name: Total All Days | $ |
Daytime Phone: Conference Fee + $40.00
E-Mail Address: Total Amount Due |

I plan to attend the Wednesday evening dinner meeting. YES [ | NO [ |




Your executive board has worked very hard to provide an array of classes that will meet your needs. Our goal
has been, and continues to be, to provide Colorado County appraisal staff with very affordable continuing
education. The CATA conference has grown to over 350 attendees, and it has become an important networking
forum for many of the Assessor’s office staff members.

We continue to contract with alternate providers to expand our educational offerings. These classes taken
outside of the CATA forum would cost 3 to 4 times what we can offer them for. Aside from negotiating a more
affordable fee, we have been fortunate enough to receive a generous grant from the Colorado Assessors
Association that has allowed us to offset our prices. Unfortunately, due to the supplement provided to us by
the CAA, we are unable to give associate members and non-members the credit that results from this
contribution. Please complete the appropriate registration form depending on your status with CATA.
Associate Member and Non-Member registrations are available on the CATA website at www.cata-log.org.
Individuals who paid membership dues by the April 1t deadline, (County employees excluded,) are Associate
members. If you did not pay dues, you are a Non-Member.

Please note the cancellation policy at the bottom of this page.

1. Please submit one registration form per member. One check may be submitted per County to cover all of
those registering. Please make checks payable to: Colorado Association of Tax Appraisers. We prefer
all forms be faxed (followed with payment by mail) to THE CATA TREASURER at:

Mail To: Fax To:
Douglas County Assessor’s Office Heidi Pleban - CATA Treasurer
Attn: Heidi Pleban - CATA Treasurer Fax Number: 303-688-2517
301 Wilcox Street
Castle Rock, CO 80104

2. Some class sizes will be limited this year and will be available until full. An e-mail will go out to
everyone with an e-mail address registered at www.cata-log.org when a class is full. Please register.

3. The classes offered by contracted providers do not necessarily pertain to Colorado Law or DPT guidelines
and mandates. They will however, offer a different perspective (fee or otherwise) and broaden your
knowledge as an appraiser. Although we have received high recommendations for each of the providers
and their classes, you take them at your own risk. All classes are approved for continuing education by
the Board of Real Estate Appraisers, unless otherwise noted.

4. The number of hours is designated with the class description by “CEH” for Continuing Educations
Hours. Failure to attend at least 80% of the scheduled class time, (100% for USPAP,) will result in denial
of any CEH for the class. The instructor will make the final determination on attendance.

5. The deadline for registering is Friday, July 20, 2007. Attempting to register after the deadline may limit
your class options substantially. General questions can be directed to any of the board members. Contact
information can be found at www.cata-log.org under “Conferences.”

6. Inadequate interest in any class may result in the cancellation of that class. If this should happen, you
may be contacted to select another class offering.

ATTENTION
NEW CANCELLATION POLICY

Cancellations of any classes from 30-10 days prior to the conference are subject to a 50% cancellation fee.
Cancellations from 10 days prior to the conference date are subject to no refund.


http://www.cata-log.org/
http://www.cata-log.org/
http://www.cata-log.org/

>
>

D.P.T. ONE-DAY APPRAISAL CLASSES
National USPAP - Standards & Ethics (7 CEH)

Focuses on changes to the 2006 edition of USPAP
USPAP will be applied to everyday appraiser practice

Rural Structures Valuation (7 CEH)

>
>

Rural Structures Policies, Procedures, and Definitions
Classification and Valuation of Rural Structures

Time Trending (7 CEH) **Class size limited to 12**

>
>
>

Introduction to Statistics
SBOE Statistical Requirements
Time Trending Techniques

Oil & Gas Equipment Valuation (7 CEH)

>
>
>

Analysis and Use of BEL's
Valuation of Installed Equipment
Valuation Stored Equipment

Introduction to State Assessed (7 CEH)

>
>
>
>

Definition of a Public Utility for Property Tax Purposes
Public Utility Industry Descriptions

Terms and Definitions Used in Public Utility Valuation
Understanding the Valuation Process

Manufactured Homes (7 CEH)

>
>

>
>

Constitutional and Statutory Provisions

Distinguishing Characteristics of Manufactured Homes, Modular,
Prefab, and Stick-built homes

Classifications and Sub-Classification Issues

Manufactured Homes Made Permanent

Oil & Gas Netback Valuation (7 CEH)

>
>
>

Constitutional and Statutory References
Oil and Gas Valuation Process
Wellhead Pricing - Methodologies

Condominium Valuation (7 CEH)

YV V V

Colorado Condominium Ownership Act
The Developer and Investor

Cost, Market & Income Approaches
Valuation of Common Elements

Sales Confirmation (7 CEH)

YV V V V

Statutory Requirements - Sales Confirmation
Court Case Discussion

Title Conveyance

Sales Confirmation Data - Implementation

Property Design & Measurement (7 CEH)

>
>
>

Design and Measurement Practices
Architectural Design
Determining Size and Style

Oil & Gas Pipeline Valuation (7 CEH)

>
>
>

Cost Market & Income Review (15 CEH) **Not Tested**

>
>
>

Statutory References
Pipeline Definitions
Pipeline Classification and Procedures

>

VYV VYV YV V VYV v VYV VYV YV V VYV

YV V V V

Aids appraisers seeking competency in the Uniform Standard

Professional Appraisal Practice (USPAP)

Slide Show
Work Problems

Basic time Trending Analysis
Performance Evaluation Analysis
Case Study

Valuation Steps
Valuation Grids

Colorado Public Utility Allocation

Apportionment of Public Utility Values

Review of Frequently Asked Questions

Hot Topics-Changes Coming for Public Utility Valuation

Moving Manufactured Homes

Discovering Manufactured Homes

Judicial Decisions Concerning Manufactured Homes
Valuation, Sales Confirmation, and Sales Ratio Analyses

Examination of Netback Spreadsheets
Accessing and Using COGCC Information

Planned Unit Development
Conversions

Mixed-use

Timeshares

Case Studies

Sales Confirmation Data-Management
Preliminary Sales Ratio Analysis

Final Data Analysis

Special Issues

HUD, FannieMae, and Ad Valorem Standards
Condominium Measurement

Determining Net Rentable Area

BOMA Guidelines

BIA Assessments
Pipeline Apportionment Procedures
Pipeline Assessment Case Study

D.P.T. TWO-DAY APPRAISAL CLASSES

Valuation Process and the Principles of Value
Principles of Value
Market Approach to Value

Advanced Income (15 CEH) Test - Mandatory

>
>
>

Investment Expectations
Capitalization Techniques
Compound Interest Tables

Cost Approach to Value
Income Approach to Value
Reconciliation

Discounted Cash Flow
Discount Rates
Glossary



D.P.T. TWO-DAY APPRAISAL CLASSES (cont'd)
Complex Residential Property and the GRM (15 CEH) Test - Mandatory

>  Definitions and Examples > History of the GRM
»  Building Materials and Structures »  Definitions
> Historical Designation >  Limitations of the GRM
»  USPAP Applications »  Using the GRM
»  Valuation Strategies »  GRM as a Unit of Comparison
Personal Property (Two-day/no test) (14 CEH)
»  Constitutional Provisions and Statutory References >  Depreciation Tables and Factors
>  Assessment Calendar > Valuation Procedures
»  Court Decisions »  Taxpayer Remedies and BIAs
>  Discovery and Listing >  Special Issues
»  Administrative Issues: Confidentiality and Penalties »  Performance Analysis
»  Classification » Case Study
Statistics (15 CEH)-Not Tested Need to have a Calculator **Class size is limited to 12**
STATISTICS- TIME TRENDING PERFORMANCE ANALYSIS
> Purpose of Statistics > Importance of Time Trending > Spotting Outliers
> Basic Assessment Statistics > Required Data > Useful Statistics
> Auditory/SBOE Statistical Requirements > Required Format > Required Data
> Manual Statistical Calc. & Problems > Data Tricks and Traps > Required Format
COMPUTER LAB > Basic Time Trending Analysis > Auditor/SBOE Statistical
> Basic Statistics Using SPSS 11.0 > Computer Hands-on Case Study Requirements
> General Data Manipulation > Data Tricks and Traps

> Utilizing SPSS 11.0 for
Performance Analysis
Computer Hands-on Case Study

D.P.T. § -DAY ADMINISTRATIVE CLASSES
Abatements (5 CEH)

>  Due Process >  Abatement Hearings
> Purpose of Abatements >  Review by Property Tax Administrator
»  Clerical Errors, Erroneous Assessments, Overvaluation Issues »  Abatement Statutes
>  Abatement Situations » Case Law
Basic Title Conveyance (5 CEH)
»  Basic Title Transfer Issues >  Types of Conveyance Documents
>  Elements of a Deed > Decedents' Estates
»  The bundle of Rights »  Assessor's Role in Keeping Ownership Records
>  Types of Ownership Assessor's Transfer Process

D.P.T. ONE-DAY ADMINISTRATIVE CLASSES

Exemptions (7 CEH)
»  Introduction to Exemptions >  Exemptions handled by the PTA

>  Exemptions handled by the Assessor >  Division/County Interaction
Certification to Taxing Entities (7 CEH)
>  Filing Deadline > Inclusions/Exclusions
»  Constitutional and Statutory Requirements »  Tax Increment Financing
»  Distribution of State Assessed Properties >  Omitted Property
»  Annexations/Disconnections »  Certification/Recertification of Levies
»  Tax Warrant

APEX INC. (3 CEH Approval Pending)
Mobile Technology for the Real Estate Professional - 3 Day (3 CEH)

WHAT'S AVAILABLE WHAT'S HOT & WHAT'S NOT HOW TO
>  Mobile Computing Hardware Solutions »  Mobile Computing Solutions »  Measure in the Field
»  Mobile Sketching Software vs. Manual »  Measuring Solutions »  Sketch in the Field
Solutions »  Tips for finding the right hardware to suit
»  Measuring Hardware Solutions your needs



AMERICAN SOCIETY OF APPRAISERS - DEANE WILSON
Introduction to Commercial Property Appraising (7 CEH)

Introduction to Commercial Property valuation is designed to introduce a student's previous knowledge and experience with the correct application

of procedures and techniques required to estimate market value of general commercial properties, which include office properties, industrial properties,
and retail properties. This class sets forth a methodical process for appraising general commercial properties and their intricacies. The material presented
in this class is designed to promote the ability to apply basic appraisal judgment and how this discernment applies.

The course covers appraiser qualifications, inspection of commercial properties, nuisances and details regarding commercial properties, neighborhood
concerns, site analysis, improvements analysis, and the three traditional approaches to value, adjustment techniques, the reconciliation process, as well as
the necessary addenda items. This is an intfroductory course, which also covers property types, data sources, for sales, rents, expenses, and

capitalization rates, as well as general concepts regarding commercial property appraising.

The Logic and Critical Thinking of Appraising & Communicating Appraisal Results (7 CEH)
This course covers the logic and critical thinking skills needed to convey sound conclusion and write more convincing reports. A brief look at English as a
second language and deeper insight into: problem solving: decision theory: argument analysis: deductive reasoning: inductive reasoning: rhetoric
versus reasoning: and much more! This is a seminar that teaches not just improved writing skills, but improved thinking. By learning the skill of
appropriate precision and the art of making sense, appraisers can better defend their conclusions, their readers will have fewer questions, and their

conclusions will have less challenges.
JAMES G. FELT ~ WATER LAW

COLORADO WATER LAW - James G. Felt Instructor
The Riparian Doctrine Change of Water Right
The Hydrologic Cycle Water Augmentation Plan
The Appropriation Doctrine Water Right Administration
Perfecting a Colorado Water Right Wells
Characteristics of the Appropriation River Compacts
Doctrine Reserved Water Rights
>  Duty of Water Denver Basin Rules
»  "Zoning" of a water right Ditches and Ditch Rights
> Waste Springs
Colorado Water Law - Day One(7 CEH)

The above listed content is designed as a fwo-day course but according to the instructor can be condensed into a one day class that omits much detail and
gives a genheral exposure to the subject matter.

Colorado Water Law - Day Two (7CEH)
The above listed content is designed to be presented as a two-day course with in depth information on appraising water rights and considerations to

be addressed and considered in water law.

Reservoirs

Colorado Water Conservation Board (CWCB)
Conveyance of Water Rights

Buying and Selling of Water Rights
Contract Considerations

Water Rights Appraisals

Geothermal Resources

Colorado Ground Water Commission

YV V V VYV
YVVVVVYVYVYYY
YV V VYV VYV VY

Kaplan College
Houses: Toxic Mold Alert & An Insider Look At The Hazards Inside (8 CEH)
Toxic Mold Alert!

Mold is the hot topic in the housing markets. This course zeros in on the key issues of mold, moisture, liability and disclosure. Mold is present in most
houses, but until recently was not perceived to be a health hazard. And this new perception is changing how houses are listed and sold. In this course, you'll
understand what contributes to moisture and water problems and how they interact to promote mold growth. We'll teach you how to educate clients about
mold and present their houses honestly and accurately. The content also covers mold troubleshooting and corrective issues.

Topics include:
»  Indoor moisture and mold growth
»  Mold and disclosure issues

Houses: An Insiders Look At The Hazards Inside
Learn the real stories and the myths about the hidden dangers inside homes. Lead, formaldehyde, asbestos, radon and mold are large issues in residential
transactions. Learning the facts about toxic substances lets you help clients reduce exposure and devise the right strategy for a successful sale.
In this course, you'll develop a good understanding of the most common indoor hazards. You'll look at how construction and remodeling materials, like carpeting
and wall sheathing, may pose concerns. The course also explores the myths and issues surrounding radon. Discover, too, why abatement is crucial to lead and
asbestos programs. This is your chance to get information on the hot issues surrounding noxious homes.
Topics include:

. Asbestos, lead and abatement

*  Formaldehyde indoors

= Radon: facts and myths

= Techniques to protect children and seniors



Introduction to SPSS - A Hands On Workshop (24 CEH) ***County Employees Only***

This class, presented by Garth E. Thimgan and James R. Thimgan is a three-day session essential for anyone wanting basic training with SPSS and a look
into time trending and ratio studies. It is designed for the complete novice and is recommended for students having limited or no exposure to SPSS.

About The Workshop: The workshop is tailored tfoward Mass Appraisal and Assessment. It begins by exploring SPSS, which includes an introduction to the
main windows that are used during an SPSS session. Each window is defined and the appropriate applications are explained and demonstrated. Once the
student has completed exploring the various windows, they are introduced to the basics in Time Trending techniques. Some methods utilized include the sale to
assessment ratio method, unit rate analysis and time as a regression variable. After the basic techniques have been introduced, hands-on labs will be utilized
to reinforce methodology. Ratio studies are the final topic covered in this class. Students will learn what statistics are most important and learn how to apply
these analyses in SPSS. Graphs and charts are a major component of SPSS and the students are shown how to use the various charts and graphs available in
SPSS for all types of analyses. Throughout the three-day class students utilize lab exercises that apply the techniques used on actual data from various
Jjurisdictions throughout the country.

IAAO

HOW TO CRITIQUE AN APPRAISAL USED TO CHALLENGE AN ASSESSMENT (7 Credit Hours)

This forum will look at appraisals submitted in support of assessment reduction requests and teach participants a methodical approach for reviewing and
critiquing these types of appraisals. Is the appraiser acting as an advocate for the client, or have they truly approached the assignment as a disinterested

unbiased third iar‘fi. Par“riciianfs will learn how to review ever‘i area of the aiir'aisal to determine the cr'edibilifi and reliabilifi of the work submitted.

Appraisal of REO'S and Foreclosed Properties (7 CEH)
This course provides a greater understanding the lending and foreclosure processes leading to Real Estate Owned (REO). Included is the development of the
traditional approaches for residential appraisals with a special emphasis on the unique challenges associated with REO and foreclosure properties from
accepting the assignment to delivering the final report.
An overview of the lending process is discussed and the role of valuation experts is explored and explained. The loan may ultimately end up in foreclosure and
result in REO requiring the services of a professional appraiser.
Examination of an appropriate Scope of Work is discussed and explained with special attention paid to the differences in traditional mortgage appraisal
assignment and a foreclosure assignment. Special attention is paid o clearly identifying the definition of value as well as assignment conditions and client
requirements.
Cost to Repair and Cost to Cure are explored with data sources to support cost estimates as well as investor incentive (risk demand) estimates extracted from
the market.
Finally a clear understating of specific Development and Reporting requirements are explored. References to Uniform Standards of Professional Appraisal
Practice (USPAP) are noted as well as Statements on Standards, Advisory Opinions to assist in empowering the appraiser in developing creditable analysis.

= Understand the lending and foreclosure process

*  Understand the need for professional valuation experts

= Understand the specific role different experts play in an assignment

= Understand accepting a REO assignment

=  Develop an appropriate Scope of Work for this type of assignment

*  How to support repair cost estimates with data sources

= Explore Investor Incentives and Risk Demand in REO appraisals

=  Explore each approach to value in relation to the assignment and assignment conditions

= How to describe specific deprecation estimates as extracted from the local market

= Understand the difference in appraising REO and foreclosure properties

= Understand the need for a clear definition of value and its source

= How multiple value estimates may be part of one assignment and the need for a concise understanding of the clients intended use

= Explore how to develop and report REO and foreclosure appraisal reports in a manner that is meaningful to the client and other intended users.

= Explore limitations of form report formats and the burden placed on the appraiser to clearly and accurately set for the analysis and conclusion in a

manner that will be meaningful and not misleading

President - Loren Morrow

1st Vice President - Raelene Churyk 2nd Vice President - Debbie Fangmeier
Secretary - Mike Peterson Treasurer - Heidi Pleban
Board Member - Jeremy Maldonado Board Member - Chris Bellegante Board Member - Kathy L. Aumand

www.cata-log.org
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